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UNDVIK DE TYPISKA FELEN
NÄR DU GÖR TRYCKFILER
Efter att ha behandlat flera miljoner tryckorder kan vi konstatera det,
att över 90 % av felen i tryckfilerna uppstår på samma ställen!

Med den här guiden kommer du att få mycket hjälp.

DE SEX DESIGNTIPSEN
Korrekt beställning / korrekta färger / Rätt filtyp / Rätt upplösning / Plats för utfall / Övertryck och output

MALLAR
Vi rekommenderar

DOKUMENTUPPSÄTTNING
Designa utan att använda mallar / Tre beskärningstips / Varför ramar och text nära kanten inte rekommenderas

CHECKLISTA INNAN DU LADDAR UPP
Sista check, sen är du redo

EXPORT AV FILER
Exportinställningar/ Så fungerar det / Fördelen / Export av enstaka sidor eller uppslag

GRATIS FILKONTROLL
Vi är redo att guida dig!

PREMIUMTRYCKFILER
Guide til premiumtryck / Övertryck / Överlappning / Små element / Felplacering / Negativ effekt



DE SEX DESIGNTIPSEN
1. GÖR EN KORREKT BESTÄLLNING

Det är viktigt att du kommer ihåg att ta med alla uppgifter i beställningen.

Vanliga beställningsdetaljer:
	Ì Produkt (vilken trycksak det gäller)
	Ì Upplaga (hur många du behöver)
	Ì Ditt telefonnummer – gärna mobil
	Ì Leveransadress
	Ì Fakturaadress

Beställ på www.lasertryck.se och undvik problem. 
Om du beställer direkt via hemsidan är du garanterad att all viktig information kommer med.

2.  ANVÄND KORREKTA FÄRGER

Med undantag av några få trycksaker med Pantonefärger trycker vi ALLT med CMYK-färger.

Kom ihåg att använda CMYK-färger i tryckfilen
I de flesta layoutprogram kan du välja att arbeta i CMYK-färger 
(i stället för RGB-färger).

Ladda ner vår CMYK-guide
Ladda ner vår CMYK-guide, som du hittar många exempel på CMYK-färger i. 
Du kan ladda ner CMYK-guide på www.lasertryck.se/fargfolder.

Så definieras färgen svart
Om du ska definiera färgen svart (till täckyta) med CMYK-färger, får du det bästa resultatet genom att välja: 
C=60 M=40 Y=40 K=100. Svart text och ritade linjer ska emellertid definieras som C=0 M=0 Y=0 K=100.

Pantonefärger
Som vi tidigare nämnt trycks några av våra trycksaker med så kallade Pantonefärger, alltså specialfärger som 
inte kan skapas med CMYK-skalan. 
Det är viktigt att pantonefärgen skapas som en specialfärg i t.ex InDesign.

https://lasertryck.se/
https://www.lasertryck.se/content/dat/download/FOLDER_2021_WEB_v1.pdf


3. ANVÄND RÄTT FILTYP

Vi klarar alla filtyper – kända som okända. Bäst resultat får du om du använder pdf-format 
med alla typsnitt inkluderade i filen.

ANDRA VANLIGA FILTYPER

Tif/jpg
I nästan alla layoutprogram kan du spara i bildformaten tif och jpg.
Spara filen med högsta kvalitet, i CMYK-färger och minst 300 ppi.
Är det text i trycksaken rekommenderar vi minst 600 ppi för optimal skärpa.

Eps
Ett populärt vektorformat, som vanligtvis ger bättre resultat än tif/jpg. Kom ihåg att konvertera alla typsnitt till kurvor
(vektoriserad/outline). Typsnitten ska också inkluderas i filen.

InDesign, Photoshop och Quark
Exportera till pdf-format – se ovan. Alternativt kan du exportera som EPS, öppna EPS-filen i Illustrator, konvertera alla
typsnitt till outlines och spara som EPS/PDF.

Microsoft Office (Word, Excel, PowerPoint, Publisher)
Skriv ut till pdf-format (kräver Adobe Acrobat eller vår gratis pdf-writer – se nedladdningssidan).

Vi vill göra dig uppmärksam på att MS Office-formaten inte är avsedda för grafiskt bruk.
Vi åtar oss därför inget ansvar för hur färgerna blir i den slutgiltiga trycksaken.

Gratis PDF-generator
Om du har problem med att skapa PDF-filer kan du ladda ner en gratis PDF-writer på www.lasertryck.se/downloads.

4. RÄTT UPPLÖSNING (PPI)

Genom att använda rätt DPI undviker du att din trycksak blir grynig och oskarp. Som standard ska alla tryck-
filer vara i 300 ppi. Vi rekommenderar dessutom att inte utforma text som bitmap.

DPI eller PPI?
Både DPI (punkter per tum) och PPI (pixlar per tum) beskriver
upplösningen (eller klarheten) av en bild, är de inte samma sak.

PPI beskriver antalet pixlar som visas per tum på en skärm. DPI används för utskrift
och beskriver antalet fysiska prickar på bläck på tryckt material.

	Ì Bilder och läsavstånd, t.ex foldrar (10-50 cm): min. 150 ppi – 300 ppi för optimalt resultat.
	Ì Bilder på stå-avstånd, t.ex affischer, roll-ups och liknande (min. 50cm): min. 60 ppi – gärna 100 ppi.
	Ì Bilder på banderoll, som läsas på flera meters avstånd: 5-50 ppi beroende på om läsavstånden är 5  

eller 20 meter.

5 ppi kan verka helt galet, men egentligen betyder det att varje pixel är 0,5 x 0,5 cm – en sån prick kan man 
inte se på 20 meters avstånd, och därför kan 5 ppi vara bra i tryck.

EPS

EPS

EPS

https://lasertryck.se/downloads


5. KOM IHÅG UTFALLET

Detta är det viktigaste rådet, eftersom det är här det uppstår flest fel.

Extra 3 mm i layouten
Det viktigaste är att du kommer ihåg att lägga till 3 mm på alla sidor av din trycksak, även kallad ”utfall”.
Text och grafiska element bör ha ett säkerhetsavstånd på minst 3 mm från trycksakens slutkant.

Undvik problem med utfall genom att använda någon av våra mallar.
Se fler beskärningstips nedan dokumentuppsättning.

6. ÖVERTRYCK OCH OUTPUT

Undvik överraskningar där något försvinner!

InDesign, Illustrator och Acrobat kan ställas in att alltid visa övertryck 
– därmed upptäcker du eventuella problem med layoutens färglager.

Övertryck i InDesign och Illustrator:
Aktivera Förhandsvisa övertryck i InDesign, då kommer all layout att simulera det färdiga trycket:
InDesign > Visa > Förhandsvisa övertryck.  
Se guide.

Övertryck i Acrobat Pro:
Upptäck fel när du går igenom den tryckfärdiga PDF-filen.  
Det rekommenderas att alltid ha övertrycks-visning aktiverad i inställningarna:
Edit > Inställningar > Sidvisning > Sidinnehåll och information > Använd Förhandsgranska övertryckning > 
Alltid  
Se guide.

Output Preview verktyg i Acrobat:
Du kan även använda Output Preview som verktyg. Aktivera “Simulate Overprint” i Acrobat: 
View > Verktyg > Tryckproduktion > Förhandsgranska utdata > Simulera övertryck.  
Se guide.

Se vår videoguide här, som berättar
hur man beskärer i InDesign. (video är på danska)

Se även vår video här och förstå hur minimala fluktuationer 
kan påverka din design. (video är på danska)

Titta på filmenTitta på filmen

Övertryck Inte övertryck

https://lasertryck.se/mallar
https://www.lasertryck.se/gfx/indesign.png
https://www.lasertryck.se/gfx/pdf-pro.pdf
https://www.lasertryck.se/gfx/pdf-vaerktoej.pdf
https://www.youtube.com/watch?v=FUtCFCyRP6w
https://www.youtube.com/watch?v=Diw1rvnaP08&t=2s


MALLAR
Vi rekommenderar att du använder någon av våra mallar när du designar din trycksak.
När du använder mallar slipper du krångla med beskärning, dokumentformat etc.

Mallarna ligger i en zip-fil som innehåller:

	Ì Mall i PDF-format
	Ì Mall i InDesign-format
	Ì Exportinställningar
	Ì Dokumentet ”Så designar du din trycksak.pdf”

Du hittar alla mallar på www.lasertryck.se/mallar.

DOKUMENTUPPSÄTTNING
Så gör du om du inte använder våra mallar.

1. Skapa ett nytt dokument 
Kan även kallas ”ny sida”, ”ny duk” eller ”ny rityta”. 

2. Dokumentuppsättning  – InDesign 
Ställ in dokumentets storlek till trycksakens färdiga mått;  
t.ex visitkort (85 x 54 mm) 

3. Lägg in 3 mm utfall och 3 mm säkerhetszon  
Detta görs i menyn ”Nytt dokument/New document”. 

4. Dokumentuppsättning – andra program 
Ställ in dokumentets storlek 3 mm större än trycksakens färdiga storlek på alla fyra sidor.  
Detta kallas för att ”lägga till utfall”.

Exempel på tillägg av 3 mm utfall:
Trycksak Färdigt mått Dokumentstorlek
Visitkort 85 x 54 mm 91 x 60 mm

A6-vykort 105 x 148 mm 111 x 154 mm

A5-lösblad 148 x 210 mm 154 x 216 mm

Ladda ner

Mallar 

Utfallszon
Bakgrundsgrafik och bakgrundsfärger
skall gå helt ut över kanten, alltså 3 mm
utöver den slutgiltliga kant.

Slutgiltlig kant
Slutgiltlig storlek på trycksaken efter utfall.

Säkerhetszon
Text, bilder och logotyper bör placeras
i den vita zonen (3 mm från den egentliga kanten).
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https://lasertryck.se/mallar


TRE BESKÄRNINGSTIPS

Följ dessa tre beskärningstips så kommer fel sällan att uppstå.

TIPS 1
Lägg upp filen i rätt storlek från början!

Slutformat: 
Layoutformat 

(inklusive utfall):
A0-format (841 x 1189 mm) 847 x 1195 mm

A1-format (594 x 841 mm) 600 x 847 mm

A2-format (420 x 594 mm) 426 x 600 mm

A3-format (297 x 420 mm) 303 x 426 mm

A4-format (210 x 297 mm) 216 x 303 mm

A5-format (148 x 210 mm) 154 x 216 mm

A6-format (105 x 148 mm) 111 x 154 mm

A7-format (74 x 105 mm) 80 x 111 mm

Visitkort (54 x 85 mm) 60 x 91 mm

TIPS 2
Bild/grafik måste gå hela vägen ut i utfallsområdet.

TIPS 3
Placera inte text för nära kanten!

Felaktig textplacering – rätt bild Korrekt placering av både text och bild

Felaktig placering av bilden Korrekt placering av bilden

Flygfältsgatan 26
128 30 Skarpnäck

Tel: 08-55 11 89 54
Mobil: 08-55 11 89 54

E-post: namn@företagsnamn.se
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Tel: 08-55 11 89 54
Mobil: 08-55 11 89 54

E-post: namn@företagsnamn.se
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Mobil: 08-55 11 89 54

E-post: namn@företagsnamn.se

Flygfältsgatan 26
128 30 Skarpnäck

Tel: 08-55 11 89 54
Mobil: 08-55 11 89 54

E-post: namn@företagsnamn.se



VARFÖR RAMAR OCH TEXT INTE REKOMMENDERAS LÄNGS KANTERNA

Se hur ett ”snett” snitt på bara 1 mm påverkar en layout som ”i teorin” är bra. 
Om vi   kunde skära mer exakt än +/- 1 mm, så var 3 mm för beskärning inte nödvändigt – men för att säker-
ställa ett bra resultat är det nödvändigt att ta med utfall.

Teori: Ramen ska vara 2 mm bred 
hela vägen runt.

Praksis: Ramen kommer till att vara
1 och 3 mm bred.

Teori: Ramen ska sitta 3 mm från kanten
hela vägen runt.

Praksis: Ramen kommer till att sitta
2 och 4 mm från kanten.

Teori: Den högra- och vänster-ställda texten
ska vara placerad 3 mm från kanten.

Praksis: Texten kommer till att sitta
2 och 4 mm från kanten.

Företagsnamn
Adress 99
128 30 Postnummer

Tel.: 88 88 88 88
Mobil: 88 55 88 55

namn@firmanamn.se

Kjell Kalmar
CEO

Företagsnamn
Adress 99
128 30 Postnummer

Tel.: 88 88 88 88
Mobil: 88 55 88 55

namn@firmanamn.se

Kjell Kalmar
CEO



PREMIUMTRYCKFILER
Även om vi är stora anhängare av att det ska vara enkelt, ställer denna typ av förfining vissa krav på din
utskriftsfil. Denna korta guide har utgångspunkt i Indesign men principerna är den samma oavsett vilket
(eget) program som används till utformningen av tryckfiler.

Vi kan lägga på tre effekter:
	Ì Guldfolie
	Ì Silverfolie
	Ì 3D-lack

Varje effekt som används måste definieras i tryckfilen som en unik dekorfärg. 
Vilka färger som används till de olika effekterna är underordnad, men optimal 
kontrast till själva tryckfilen är en fördel.

Partiell lack namnges ”VARNISH”, silverfolie ”SILVER” och guldfolie ”GULD”
– alltid med stora bokstäver.

ÖVERTRYCK

Övertryck skall alltid användas på dom partiella elementen – oavsett om det 
ligger tryckfärg under effekten.

ÖVERLAPPNING 

Effekter som överlappar varandra, ska separeras var för sig, så det inte ligger flera lager uppe på varandra.  
Anledningen är att det används lack som fäster på folien, och lager med överlappning gör att det blir för tjockt.  
Fig. A1 nedan visar de tre varianter i den färdiga filen. Fig. A2 visar när elementen är separerade från varandra.

SMÅ ELEMENT

Tänk på att partiell lack och folie fungerar bäst om elementen ligger minst 3 mm ifrån varandra, från kant 
och/eller vik. Vi rekommenderar inte punktstorlekar under 12 poäng.

Fig. A1 Fig. A2

VARNISH (lack) SILVER (silver) GOLD (guld)



FELPLACERING

Då varje effekt läggs på tryckarket i en särkild arbetsgång, kan felplacering förekomma på elementen med en
liten tolerans (Fig. B1). Se till att alltid ha marginal till detta i designen.
Fig. B2 visar en felplacering på endast 0,3 mm.

NEGATIV EFFEKT

Önskas negativ effekt i folier, skall element som t.ex. text som visas till vänster (Fig. C1) vara med en viss 
tolerans.
Guldfolien överlappar den bakomliggande grafiken, samtidigt som det är tagit höjd för feltryck.
Fig. C1 är gjord med en vit låda som bakgrund (Fig. C2).
Samma uppgift kan lösas med en linje som man kan lägga på texten (Fig. C3).

Fig. B1 Fig. B2

VARNISH (lack) SILVER (silver) GOLD (guld)

Ficipiet fuga. Mint 
occusa que plignis et 
ad eatem rerum aut 
et andis est, quam 
ratem quam lia niet 
labor alMo tem inc-
tem. Dam alibusdae

Ficipiet fuga. Mint Ficipiet fuga. Mint 
occusa que plignis et occusa que plignis et 
ad eatem rerum aut ad eatem rerum aut 
et andis est, quam et andis est, quam 
ratem quam lia niet ratem quam lia niet 
labor alMo tem inc-labor alMo tem inc-
tem. Dam alibusdaetem. Dam alibusdae

Fig. C1 Fig. C2 Fig. C3



FÄRGPROFILER
Ì Till bestruket (coated) papper, t.ex Silk, rekommenderar vi FOGRA39.
Ì Till obestruket (uncoated) papper, t.ex offset, rekommenderar vi FOGRA47.

EXPORT AV FILER
Vi rekommenderar att du laddar ner och installerar våra exportinställningar om du designar din trycksak med 
hjälp av Adobes program (InDesign, Illustrator och Photoshop).

SÅ HÄR FUNGERAR DET

1. Ladda ner zip-filen och packa ut den
2. Dubbel-klicka på filen ”SPG2020”
3. Exportinställningarna är nu installerade och finns i din InDesign-meny.
4. Välj ”File” > Adobe PDF-förinställningar” > ”SPG2020”

Ladda ner exportinställningarna i QR-koden eller här: www.lasertryck.se/downloads.

FÖRDELEN MED EXPORTINSTÄLLNINGAR

När du använder våra exportinställningar, är du mer säker på, att det är koll på:

• Problem med transparens
• Problem med uttfall
• Problem med saknad font
• Problem med för hög upplösning

KORREKT EXPORT – SIDA FÖR SIDA ELLER UPPSLAG

När du exporterar din tryckfil från InDesign kan du välja att exportera sidorna
som enstaka sidor eller uppslag.

	Ì Merparten av trycksakerna måste exporteras som enstaka sidor i ett 
 dokument (pdf) och i rätt ordning.
	Ì Omslag och foldrar måste exporteras som uppslag i ett dokument (pdf),  

 och sidorna måste vara korrekt sammansatta. 
 Tänk på att sätta in en rygg om det är en limmad bok.

Ladda ner

Unavngivet 1   2-3Unavngivet 1   2-3 29-11-2021   11:19:0329-11-2021   11:19:03

Unavngivet 1   1Unavngivet 1   1 29-11-2021   11:18:1129-11-2021   11:18:11

Uppslag

En sida

https://lasertryck.se/downloads


CHEKLISTA INNAN DU LADDAR UPP
 5 Korrekt utfall

Jag har gjort korrekt utfall och min tryckfil är därför 3 mm större på alla kanter än den slutliga trycksaken.

 5 Korrekt säkerhetszon
Jag har placerat text, grafik och loggor innanför säkerhetszonen (minst 3 mm från trycksakens kant).

 5 Korrekt upplösning
Alla bilder i min tryckfil har en upplösning på minst 300 dpi, när de är placerade i 100 % i dokumentet. 
Psssst... Om du är osäker på om upplösningen är tillräckligt bra, förstora din skärm till 200-300 %. 
Om det fortfarande ser skarpt och icke-pixlat ut, så kommer det också att se snyggt ut i tryck.

 5 Korrekta färger
Min tryckfil är gjord med CMYK-färger. Har jag satt in bilder eller annat i RGB-/Pantone-färger, låter jag 
LaserTryck.se konverterat till CMYK-färger för att få det bästa resultatet.
Jag känner till att färgerna kan ändra sig vid konverteringen.

 5 Korrekt PDF med inkluderade typsnitt
Alla typsnitt är inkluderade när jag exportade min PDF-fil. 
Använder du våra exportinställningar (se här) eller exporterar du som ”high quality” / ”press quality”,  
sker detta automatiskt.

 5 Inget uppslag (vid trycksaker med flera sidor)
Min PDF-fil innehåller sidorna efter varandra. En 24 sidors broshyr kräver därför en PDF-fil med 24 sidor.  
Skicka därför inte PDF-filer med sidorna placerade mitt emot varandra / som ett uppslag.

GRATIS FILKONTROLL
Är du osäker på om din fil kan användas för tryckning, erbjuder vi gratis kontroll av dina tryckfiler helt utan 
förpliktelser.

Vanlig kontroll:
	Ì Korrekt beskärning
	Ì Korrekt upplösning  (dpi)
	Ì Format / filtyp
	Ì Korrekta färger 

Se mer på www.lasertryck.se/filkontroll. 

https://lasertryck.se/filkontroll
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